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Chapter 1 - Introduction to the program

Introduction to the program

The program is used to determine some of the most important hydrogeological parameters (transmissivity and
storativity coefficient) of free, confined and semi-confined aquifers through the interpretation of the well tests.

These parameters can be calculated both through direct analytical interpretations, as through automatical
interpolation and best fit conditions on the most important tables, starting from well discharge measurements
performed on single wells as well as on fields with wells equipped with piezometers.

Diverse methods are used as shown in the literature, illustrated further on, depending on well and aquifer type.

The output of the calculations is made up of drawings for interpretation, as explained further on, and can have a
Cartesian, logarithmic or bi-logarithmic scale, depending on the method chosen

The description of the many methods used by the program can obviously not be treated in an comprehensive
fashion in this manual, the reader is referred to the specialised literature.
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Chapter 2 - System requirements and program
installation

System requirements

• Pentium® class processor

• Microsoft® Windows® 95 OSR 2.0, Windows 98, Windows Me, Windows NT®* 4.0 with Service Pack 5 or
6, Windows 2000, or Windows XP

• 64 MB of RAM (128 MB recommended)

• 100 MB of available hard-disk space

• CD-ROM drive

• A printer driver must be installed, even if the printer itself is not connected to the PC.

Program Installation

To install WELL run the well32setup.exe installation package from the CD-ROM or from the download
directory.

Press the Setup button…
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…and select the directory to create the WELL32 folder.

Click the Continue button and the program program is automatically installed.

The first time you run the program the window that allows you to select your preferred language appears.
Simply click on the flag of the language you prefer.

The language selection will be saved in the “LANGUAGE.CFG” file, which is found in the program directory. To
select another language, it is sufficient to exit the program and delete this file. The language selection window is
shown once more at the next run of the program.
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Chapter 3 - The program protection

Hardware protection key

This section should instead be carefully read if the program was bought through the Internet.

Hardware protection key - Parallel port
Plug the hardware protection key that is supplied with the program into the parallel port connector of your PC.

The hardware key should be plugged directly into the PC, before any other device, to avoid hardware conflict
with other keys.

The printer cable can then be connected to the hardware protection key, as it does not interfere with the printing
operation. If the hardware key has not been correctly installed, the program will start in demo mode.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98 and Windows Me

Windows 95, Windows 98 and Windows Me automatically recognize the hardware key, so no other operation is
required.

Windows NT, Windows 2000 and Windows XP

Windows NT, Windows 2000 and Windows XP require the installation of a software driver to enable access to
the hardware key. To install the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. install the package

3. browse the program directory, and run the program SKEYADD.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

4. restart the computer

To uninstall the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYRM.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

3. restart the computer

Hardware protection key - USB port
Plug the hardware protection key, supplied with the program, into one of the USB connectors of your PC.

For further information about the hardware key, please visit the Web site http://www.eutron.com
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Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP

All Windows versions, except Windows NT, automatically recognize the PnP hardware key, and require the path
to load the driver from. To install the driver, follow this procedure:

1. start Windows, and login as Administrator (if necessary)

2. install the package

3. browse the program directory, and select the folder HardKeyDrivers\ USB_9x-Me-2000-XP

Windows NT

Windows NT requires the installation of a software driver to enable the access to the hardware key. To install
the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. install the package

3. browse the program directory, and run the program SKEYUSBADD.EXE in the folder
HardKeyDrivers\USB_NT4

4. restart the computer

To uninstall the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYUSBRM.EXE in the folder
HardKeyDrivers\USB_NT4

3. restart the computer
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Chapter 4 - Using the program in a local
network

Using the program in a local network

The programs can be used in a local network without moving the hardware key from one computer to another.

It is also possible to purchase multiple licenses to use the program on several computers at once.

The computer to which the hardware key is physically connected is defined as the “Server”, and the computer
that requests the authorisation to run in fully operational mode from to the Server is defined as the “Client”.

The program must be installed on the Server (with the proper hardware key drivers if necessary), and on each
Client (in demo mode).

The program keyserver.exe should also be installed on the Server. The installation file of this program can be
found on the distribution CD-ROM, or on the Internet, at the URL:

http://www.geoandsoft.com/download/KeyServerSetup.exe
Run keyserver.exe and the hardware key management window appears.

Click the “Create Program Configuration File” button, and browse your network to select the executable file you
want to remotely activate (for example \\computer03\c\program files\well32\well32.exe).

Now, with the keyserver.exe program running, well32.exe can also be run from the PC “computer03”.

NOTE: the contemporary use of the program on more then one computer is allowed only if a multiple
license has been purchased.
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Chapter 5 - General information

Usage Notations

Some typographical notations and keyboard formats are used in this manual to help locate and interpret
information more easily.

Bold print is used to indicate command names and related options. Characters appearing in bold print should
be typed exactly as printed, including spaces.

Words written in italics indicate a request for information.

CAPITAL letters are used to indicate computer, printer, directory, and file names.

Keyboard formats are used as follows:

• KEY1+KEY2 - indicates press and hold down key1 and then, at the same time, press key2. For example,
alt+c means one should press and hold the alt key down and, at the same time, press the c key. The keys
are always indicated with capital letters.

• key1,key2 - A comma (,) between key names means that the keys must be pressed in sequence. For
example, ALT,C means one should press and release the ALT key and then press and release the C key.

Because of the differences in keyboard layouts, the names of the keys on the keyboard may not correspond
with those described in this manual. The word ARROW (LEFT, UP, RIGHT, DOWN) indicates the use of the arrow
keys.
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Chapter 6 - User Interface

User Interface and Data Entering

The user interface is designed to be easy to use and powerful and is supported by complete on-line help. This
help contains practical hints and the theoretical background, where applicable. It should reduce the requirement
of  frequently consulting the printed manuals.

All the commands are located inside a menu bar. Each menu contains a list of commands that one can select
with the mouse or the keyboard. The arrangement of the menus, designed with ergonomic criteria, follows the
logical order of the operations, inhibiting the access to further operations until all the necessary data have been
entered.

The interface layout is maintained in all of our programs, to simplify, as much as possible, the transition from
one program to another to avoid having to learn different commands and procedures for similar functions (such
as entering data or managing files).

Let us examine the general components that are available in the user interface of geo&soft programs.

User Interface: Menu Bar and Menus
The Menu Bar manages the access to all the program commands. The goal of the menu design is to offer an
ergonomic, simple, and understandable arrangement of the commands.

The menus used to perform a complete operation are normally ordered left to right and top to bottom. When
possible, the following scheme is used: definition of the name of the project, entering the required data,
performing the calculation, and generating the output as a preview or final print.

The programs automatically disable some menus or commands when the execution of such menus or
commands is not yet feasible. Typical examples are: a calculation menu is disabled when not all the data
needed for the calculation have been completely entered, or a print menu is disabled if not all the calculations
have been executed.

To choose a command from a menu, use the following procedures:

! Point the menu that is to be activated, click the left button of the mouse, then point the command to be
activated, and click the left button of the mouse again. If one does not wish to select any command
from the menu that is open, exit the area of the menu before releasing the mouse button.

" Press the ALT key to activate the menu bar. Press, on the keyboard, the underlined character in the
menu name or press ENTER or the DOWN arrow, to select the first menu. Press on the keyboard the
underlined character in the menu name or select it using the arrow key and then press ENTER, to
execute a command in the selected menu. Press ESC to close the menus without executing any
command.
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The Graphical Output Preview Window
The Toolbar is located in the upper side of the preview window.

The Toolbar allows fast access to the commands with the mouse. Click the corresponding icon, to select one of
the commands that belong to the Toolbar. The Toolbar displays the following commands:

- Zoom + : clicking the first icon activates the ZOOM function (it can only be used with the mouse) that
permits the enlargement of part of the drawing. The function remains active until the Zoom - icon is selected.
To enlarge a part of the drawing:

! click the icon, and then select the area to be enlarged by clicking the upper-left corner and dragging
the mouse pointer to the lower-right corner. At this point, release the mouse button. Note: due to the
low resolution of the screen, the texts could appear in a slightly different scale at different zoom levels.
This does not affect the quality of the final printouts.

- Zoom - : click this icon to return to the original scale of the preview.

- Arrows: click the arrow icons, in "Zoom + " mode, to pan the on-screen preview.

- Print: click the print icon to send the drawing to the default printer.

- Resized print: click this icon to send the drawing to the default printer. The image will be resized to fit the
current paper size.

- DXF: one can export the graphic output as a DXF file by clicking this icon; it gives access to a dialogue
window that enables one to assign a different name to the DXF file, which has, by default, the same name
as the current project.

- EMF/W: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Microsoft Word. Clicking this icon gives access to a dialogue window that enables
one to assign a different name to the EMF file, which has, by default, the same name as the current project.

- EMF/D: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Corel Draw. Clicking this icon gives access to a dialogue window that enables one
to assign a different name to the EMF file, which has, by default, the same name as the current project.

- Exit: click this icon to close the preview window and return to the main menu.

The Input Dialogue Windows
The different menu commands can perform an immediate action, or display a dialogue window in order to input
or edit the various data sets.

When a dialogue window is visible, all the actions that do not pertain to it are ignored. Hence, it is necessary to
close the dialogue window to resume the normal use of the program.

Some fundamental tools are used inside the dialogue windows: data fields such as text and list boxes, and
buttons.
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The text boxes are used to input numerical values and text strings. Most of the editing keys (HOME, END, INS,
DEL, etc.) can be used inside these fields. If one sees a small arrow pointing down on the right side of the data
field, one has a list box.

To scroll the list box and select an item, do as follows:

! click the arrow, and then click the item to be selected.

" press the DOWN arrow until one arrives at the item to be selected. It is also possible to press a letter to
directly reach the first item that begins with that letter.

Tere are three buttons in the dialogue window:

• <Ok> - this button saves the entered information and goes on to the next phase.

• <Cancel> - this button closes the Dialogue window without saving the just entered data, or without
executing the command.

• <Help> - this opens a window that contains general information on how to use the dialogue windows.

To use the buttons:

! click the button

" press alt+underlined letter

To edit the data inside the dialogue window, use the following keys:

• TAB - moves the cursor to the next field; when the cursor is inside the last visible field the cursor goes to the
first control button of the Dialogue window. To return to the previous field, press SHIFT+TAB.

• ENTER - moves the cursor to the next field. If the cursor is positioned on one of the window buttons, the
corresponding command is executed.

• BACKSPACE - cancels the last character that has been entered.

• DEL - cancels the character to the right of the cursor.

• ESC - closes the Dialogue window without saving the entered values or without executing the command. The
<Cancel> button will do the same.

• UP ARROW/ DOWN ARROW - these are used in multiple fields, or those fields that have a list box.

• LEFT ARROW/ RIGHT ARROW - moves the cursor to the previous or next field.

• HOME -moves the cursor to the beginning of the field.

• END - moves the cursor to the end of the field.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Data Input With Tables
Tables are used to enter long sequences of numerical values and/or text strings. The keys to be used are the
following:

• TAB - moves the cursor to the first button in the window. When one presses this key again, the cursor is
moved to the next button.

• SHIFT+TAB - moves the cursor to the previous button.

• ENTER - moves the cursor into the next input field. If the cursor is positioned on one of the window buttons,
the corresponding command is executed.

• PAGE UP - moves the cursor up 15 lines.

• PAGE DOWN - moves the cursor forward 15 lines.

• UP ARROW - moves the cursor to the input field directly above.

• DOWN ARROW - moves the cursor to the input field directly below.

• LEFT ARROW / RIGHT ARROW - moves the cursor to the field respectively to the left or to the right of the current
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position.

• HOME - moves the cursor to the beginning of the line.

• END - moves the cursor to the end of the line.

• F2 - copies the field contents to the extended editing field under the title bar in order to facilitate the editing
of the long strings. When working in this editing field, please REMEMBER to press ENTER, even before
clicking the <Ok> button. Double-clicking a field has the same effect as pressing the F2 key.

The tables have two additional buttons:

• <Insert> - creates an empty line before the one in which the cursor is positioned.

• <Delete> - deletes the line in which the cursor is positioned.

IMPORTANT SUGGESTION: you can copy data to or from other programs such as Microsoft Excel:

The data entered in the table can be copied in order to be pasted into another table.

To copy the table’s contents:

" press the key combination CTRL+C. The contents will be copied into the Clipboard of Windows.

To paste the Clipboard contents into the table:

" press the key combination SHIFT+INS, or CTRL+V.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Message Windows
The function of these windows is to give information to the user concerning the system status, as in the case of
an error due to an improper use of the program.
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Help On Line
A complete Help On Line is available. It is possible to ask for information or suggestions related to the
commands or the use of the program. In order to access the help on line, proceed as follows:

1. Position the cursor on a field of a dialogue window and press F1.

2. Use the Summary from the Help menu.



13 - WELL for Windows – User Guide

Chapter 7 - Commands

Files Menu (ALT,F)

This menu contains the commands for opening and saving files. In these all the information relative to the
project is stored. Until a name is given to the work the program will not permit the use of other menus.

New Command (ALT,F,N)
To open a new file:

! from the menu choose New by first clicking on the name of the menu then on the New command.

" from the File menu choose New by using the combination of the keys ALT,F,N.

Open Command (ALT,F,O)
To be able to work with the program one should, first of all, create a new file or open a pre-existing file.

To open a file:

! from the menu choose Open by first clicking on the name of the menu then on the Open command. In
the File Name field type the name of the file to be opened or, if the file already exists, double click on
the name of the desired document which can be found in the list underneath the File Name field.

" from the File menu choose Open by using the combination of the keys ALT,F,O. In the File Name cell,
type the name of the file to be opened or, if the file already exists, press TAB and then the UP ARROW or
DOWN ARROW to select the name from the list underneath the File Name field and press ENTER.

The name of the file being used is reported inside the title bar of the main window and inside a window referable
by selecting the Help menu.

The name of the file should not contain spaces and/or punctuation marks. It is not necessary to indicate
extensions, since the extension “.WEL” is added automatically: for example, the given name “TEST” will have
the file name “TEST1.WEL"

Save Command (ALT,F,S)
During the work session the program uses a copy of the file which is temporarily loaded into the computer’s
RAM. To save work on the hard disk it is necessary to use the Save command; otherwise all the data introduced
will be lost when one exits from the program. If an electrical problem or any other type of problem interrupts the
computer’s functioning all the data not yet saved will be lost, so it is advisable to save the work often.

To save a file:
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! select Save from the file menu by clicking first on the name of the menu and then on the Save
command. In the File Name field, the name given to the file when it was originally opened appears. To
confirm that name click on the <Ok> button. To assign a new name to the file, type the new name in
this field.

" select Save from the File menu by using the key combination ALT,F,S. To confirm the name given to
the file when it was opened press ENTER. To assign a new name, type the name in the File Name field
and press ENTER.

The program will save the file in the current disk unit and directory unless specified otherwise. To save the file
on a different disk unit or in a different directory, type the full path in the File Name field. For example, to save
the document in the root of disk C: type c:\filename or select a different unit or directory.

Printer Setup Command (ALT,F,C)
By selecting this command one goes to “Print” dialog box. Here one can verify and modify the Default printer’s
Setup or select another printer from those installed one ones system.
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Edit menu (ALT,E)

Through this menu the input data necessary for the determination of hydrogeological parameters of the aquifer
are entered.

Also, through this menu, the test methods to be applied to the well are selected.

Normally test are normally performed under transitory flow conditions and only, in a few cases, under stationary
flow conditions; likewise one works with constant flow rates and only rarely with variable flow rates in steps.
WELL contemplates many methods to interpret the tests performed under transitory flow and constant rate while
only few methods are contemplated for test under stationary flow.

Through the use of useful simplifications it is possible to use some methods also with tests that do not satisfy
entirely the required starting conditions. Let us consider an example: hydraulic test normally require the
presence of more piezometers or observation wells near the tested well; the methods that use one piezometer
only can be used anyway even when one works with only one pumping well by simulating the presence of a
piezometer near to the well at condition that one wants only to determine transmissivity.

The methods available have been subdivided by aquifer type; if one is not of the aquifer type it is best to use
methods that employ logarithmic diagrams capable of giving, according to the curve obtained, indications on the
aquifer.

Well Radius Command (ALT,E,R)
This enables one to define the well bore radius. This is only necessary for methods that use the readings of the
decreases of water level in the well itself.

The radius should be expressed in meters. To close the window click on the <Ok> button.

Distances Piezometers Command (ALT,E,D)
Through this the “Well - piezometers distance” dialogue window is opened.
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The program can handle up to 10 control piezometers, each of which is identified by its distance from the well.
To close the window click on the <Ok> button.

Times Command (ALT,E,T)
Through this command the “Decline read-off time” dialogue window is shown.

Up to 50 readings can be analysed, which should be expressed in minutes. For test executed with stationary
flow one should use a number equal to 1 (one); this value, obviously not used in the calculation phase, is
however necessary to the program to enable it to go on and input the other data in successive windows.

The times can be entered without a precise order as the program automatically reorders them in increasing
order when one exits the window.

To delete a time previously entered it is sufficient to delete the field’s content.

For rising test the initial time should not be zero and coincide with the pumping time.
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To close the window click on the <Ok> button.

Flow Command (ALT,E,F)
Through this command the “Flow” dialogue window is shown.

For each time indicated in this window the flow, expressed in m3/min, should be entered. The program
duplicates automatically the last value entered in the following fields left open or with value zero. In such a way
entering procedures are speeded up for the constant flow and the stepped tests.

To close the window click on the <Ok> button.

Drawdown inside the well Command (ALT,E,I)
Through this command the drawdown values measured in the well are entered. For each time the program
requires the drawdown, expressed in meters, measured in the well.

With the recovery method the real values of drawdown should be entered (thus decreasing) and not the
recovery values. The initial drawdown value should be the real drawdown registered when pumping stopped.
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To close the window click on the <Ok> button.

Drawdown in Piezometer Command (ALT,E,P)
Through this command the “Piezometer Drawdown” dialogue window is shown. Th program shows two different
windows depending on the number of readings effected.

- in the case of one time only, a window is shown that has sufficient fields for ten piezometers. For each
piezometer the drawdown encountered is entered.

- in the case of more times the piezometer number is asked for which one wants to enter or edit the data, hence
a table is shown where the drawdown is entered where each field is preceded by the reference time.

In the recovery test one should enter the real drawdown times (hence increasing) and not the recovery data.
The initial drawdown value should be the real drawdown value measured at the moment pumping was
interrupted.

To close the window click on the <Ok> button.

Geometric Parameters Command (ALT,E,G)
Through this command the geometrical parameters of the aquifer are defined. Entering these data is required
for those methods that  use incomplete wells and for inclined aquifers.
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For the Lefranc test one should also define the cavity to determine the form coefficient as well as the filter length
and hydraulic load applied.

To close the window click on the <Ok> button.

Efficiency Parameters (ALT,E,E)
Through this command some parameters are defined, necessary to evaluate the hydraulic efficiency of the wells
under operation and one wishes to use the gradient test by Rorabaugh and Jacob.

The program uses for these methods the Rorabaugh equation:

Sm = BQ + CQn

where:

B = B1+B2+B3 = proportionality coefficient of the total laminar flow component of the load losses, measured in a
well under real conditions.

C = proportionality coefficient of the total turbulent flow component of the load losses, measured in a well under
real conditions.

n = exponent of the turbulent flow component of the load losses, measured in a well under real conditions. For
n= 2 the Rorabaugh equation coincides with the one proposed by Jacob.

From the flow rate readings at different times the program determines the optimal values for the B, C and n
parameters. Once there values are calculated the program calculates the hydraulic efficiency of the well using
the following equation:

E = 100 (B1Q / (BQ + CQn))

Using the equation mentioned above requires one to determine the values for the B2 and B3 coefficients,
necessary to obtain the value of B1, which, multiplied by the amount of flow represents the load losses in the
aquifer flow.

The evaluation of the B2  coefficient is performed using the following algorithm (TNO, 1964):

B2 = (1 / 2πT) ((1 – δ)/δ) [ln (4b/rw) – F(δε)]

where:

T = aquifer transmissivity
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δ = adimensional length of the productive section with filters.

ε = eccentricity of the productive section with filters, given by the formula ε = |(2a + L – b) /2b| with L = length of
the productive section with filters

b = saturated thickness of the aquifer

rw = well radius

In the “Hydraulic Efficiency” dialogue window one ought to enter:

→ well radius (r)

→ eccentricity of the section with filters

→ aquifer thickness

→ length of the section with filters

→ transmissivity

→ radius of the area possibly affected by damage to permeability (r’)

→ average hydraulic conductibility of the aquifer when r is larger than r’

→ aquifer conductibility

Method Selection Command (ALT,E,S)
Through this command the “Calculation Method Selection” dialogue window is shown. The program presents
the different calculation methods, subdivided by aquifer type, wells and pumping method.
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→ Artesian aquifer - Completed Well - Stationary flow - Thiem 1 (Exam00.Wel, Exam01.Wel): the drawdown of
2 or more piezometers is required. In case one has one piezometer only, the pumping well can be used
when radius and drawdown is known.

→ Artesian aquifer - Completed Well - Stationary flow - Thiem 2 (Exam02.wel, Exam03.Wel, Exam04.Wel): the
drawdown of 2 or more piezometers is required. In case one has one piezometer only, the pumping well can
be used when radius and drawdown is known.

→ Artesian aquifer - Completed Well - Stationary flow - Cassan (Exam29.Wel): the drawdown of 2 or more
piezometers is required as well as the aquifer’s gradient.

→ Artesian aquifer - Completed Well - Transitory flow - Theis (Exam05.Wel): the drawdown of one piezometer
at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Theis (Exam06.Wel, Exam07.Wel, Exam08.Wel): the
drawdown of 2 or more piezometers at one time only is required.

→ Artesian aquifer - Completed Well - Transitory flow - Theis (Exam09.Wel): the drawdown of 2 or more
piezometers at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Sheanan (Exam10.Wel): the drawdown of one
piezometer measured at time intervals double to the preceding one (e.g. t=1,2,4,8,16) is required.

→ Artesian aquifer - Completed Well - Transitory flow - Jacob 1 (Exam11.Wel): the drawdown of one
piezometer at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Jacob 2 (Exam12.Wel): the drawdown of 2 or more
piezometers with one time only is required.

→ Artesian aquifer - Completed Well - Transitory flow - Jacob 3 (Exam13.Wel): the drawdown of 2 or more
piezometers at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Chow (Exam14.Wel): the drawdown of one piezometer
at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Franke 1 (Exam15.Wel): the drawdown of one
piezometer at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Franke 2 (Exam16.Wel): the drawdown of one
piezometer at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Recovery - Theis 1 (Exam32.Wel): the drawdown of
one piezometer at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Recovery - Theis 2: the drawdown of 2 ore more
piezometers at one time is required.

→ Artesian aquifer - Completed Well - Transitory flow - Recovery - Jacob (Exam33.Wel, Exam39.Wel): the
drawdown of one piezometer at n times is required. The program uses automatically the well data when
drawdown of piezometers are not defined.

→ Artesian aquifer - Completed Well - Transitory flow - Constant drawdown - Jacob 1 (Exam17.Wel): the
drawdown of one piezometer at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Constant drawdown - Jacob 2 (Exam18.Wel): the
drawdown of one piezometer at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Steps - Aron (Theis) (Exam19.Wel): the drawdown of
one piezometer at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Steps - Aron (Jacob) (Exam20.Wel): the drawdown of
one piezometer at n times is required.

→ Artesian aquifer - Completed Well - Transitory flow - Steps - Cooper (Exam21.Wel, Exam22.Wel): the
drawdown of one piezometer at n times is required.

→ Artesian aquifer - Incomplete Well - Stationary flow - Jacob (Exam23.Wel): the drawdown of 2 or more
piezometers and the aquifer thickness is required.

→ Artesian aquifer - Incomplete Well - Transitory flow - Hantush 1 (Exam24.Wel): the drawdown of one
piezometer of the initial depth and the length of the filters of the piezometer and the well are required.

→ Artesian aquifer - Point-like Well - Transitory flow - Kanwar (Exam25.Wel, Exam26.Wel): the drawdown of
one piezometer at n times is required.

→ Phreatic aquifer - Stationary flow - Thiem (Exam27.Wel): the drawdown of 2 ore more piezometers at one
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time is required.

→ Phreatic aquifer - Stationary flow - Dupuit (Exam28.Wel): the drawdown of 2 ore more piezometers at one
time is required.

→ Phreatic aquifer - Stationary flow - Cassan: the well’s radius, drawdown, the gradient and the aquifer’s
thickness is required.

→ Semi-artesian aquifer - Stationary flow - De Glee (Exam30.Wel): the drawdown of 2 ore more piezometers is
required.

→ Semi-artesian aquifer - Stationary flow - Hantush (Exam31.Wel): the drawdown of 2 ore more piezometers is
required.

→ Semi-artesian aquifer - Stationary flow - Walton (Exam37.Wel): the drawdown of 2 ore more piezometers is
required.

→ Semi-artesian aquifer - Stationary flow - Hantush: the drawdown of one piezometer at n times is required.

→ Constant load tests - Lefranc (Exam34.Wel): the well’s radius, the read-off time of drawdown and drawdown,
the well type the length of the filter and the hydraulic load are required.

→ Variable load tests - Lefranc (Exam35.Wel): the well’s radius, the read-off time of drawdown and drawdown,
the well type the length of the filter are required.

→ Stepped - Rorabaugh (Exam36.Wel): one ought to know the times at which the measurements were taken
and the relative flow data, the well radius (r), of the section with filters and its eccentricity, the radius of the
area possibly affected by damage to permeability (r’), aquifer thickness, transmissivity, aquifer conductibility
as well as average hydraulic conductibility of the aquifer when r is larger than r’.

→ Stepped - Jacob (Exam38.Wel): one ought to know the times at which the measurements were taken and
the relative flow data, the well radius (r), of the section with filters and its eccentricity, the radius of the area
possibly affected by damage to permeability (r’), aquifer thickness, transmissivity, aquifer conductibility as
well as average hydraulic conductibility of the aquifer when r is larger than r’.

Diagram Heading Command (ALT,E,M)
The program enables one to enter into the final output, tables or drawings, up to five lines of text that will be
used as titles in the output.

Disactivation Times Command (ALT,E,V)
Through this command one can select the readings that should be used by the program during the calculation
phase.
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The disabled readings, even when not used in the calculation, are shown in the drawings albeit in a different
colour.
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Print Menu (ALT,P)

Through this menu it is possible to get the output as drawings or listings, after selection from the menu, of the
data to be shown.

Graphics Command (ALT,P,G)
When this program is selected a menu is shown through which can select the graphical output to be printed.

Diagram Calculation Result Command (ALT,P,G,D)

Enables one to visualise and print the graphical output of the results obtained. The drawing will be different
according to the method selected.

Cartesian Diagram Command (ALT,P,G,C)

Through this command the data that have not yet been calculated are shown on a Cartesian plane, the program
determines automatically if the independent variable should be distance or time.

Semi-logarithmic Diagram Command (ALT,P,G,S)

Through this command the data that have not yet been calculated are shown on a plane with a logarithmical
abscissa and linear ordinate; the program determines automatically wether the independent variable should be
distance or time.

Bi-logarithmic Diagram Command (ALT,P,G,B)

Through this command the data that have not yet been calculated are shown on a plane with a logarithmical
abscissa and ordinate; the program determines automatically wether the independent variable should be
distance or time.

Optimal Capacity Diagram Command (ALT,P,G,O)

To determine with larger precision the value of optimal flow for a well which is subject to evaluation errors the
program constructs a Q2/s-Q diagram that shows an approximately Gaussian distribution whose maximum
represents the optimum flow.

Drawdown Diagram (Flow) Command (ALT,P,G,D)

Enables one to visualise and print the graphical output of the results obtained. Only for Stepped methods.

Specific Drawdown Diagram (Flow) Command (ALT,P,G,F)

Enables one to visualise and print the graphical output of the results obtained. Only for Stepped methods.
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Drawdown Diagram (Specific Flow) Command (ALT,P,G,M)

Enables one to visualise and print the graphical output of the results obtained. Only for Stepped methods.

Listings Command (ALT,P,L)
By selecting this command the program opens a sub-menu where one can select the preview mode, and wether
to print or export the listing.

Listings Preview Command (ALT,P,L,P)

With this command it is possible to preview the listings pertaining to the calculation result. The listing can not be
changed here.

To scroll the text use the scroll bars on the window or use the UP and DOWN arrow keys, or the PAGE UP e PAGE
DOWN. keys. To exit press ESC or double-click any point of the listing.

The file containing the listing is saved on disc in the same directory where the data files resides. It has the same
name with the difference of the ".TAB" extension. The file is in the normal ASCII format and its pagination is
such that all commands have the # sign as prefix.

Listings Direct Print Command (ALT,P,L,D)

With this command the listings pertaining to the calculation result are printed directly.

Listings Export to DOC (ALT,P,L,E)

With this command the listings pertaining to the calculation result are exported in the format used by Microsoft
Word 97.

The file will have the same name but with the ".DOC" extension and will be saved in the same directory where
the data files reside.

Listings Export to TXT (ALT,P,L,T)

With this command the listings pertaining to the calculation result are exported in the “Text only” format.

The file will have the same name but with the ".TXT extension and will be saved in the same directory where the
data files reside.

Listing Export to SLK (ALT,P,L,S)

With this command the listings pertaining to the calculation result are exported in the “SLK” format.

The file will have the same name but with the ".SLK" extension and will be saved in the same directory where
the data files reside.

At the end of the file exportation this file will be visualised by invoking the Excel program.

Configure Command (ALT,P,C)
With this command, one can define the graphical properties of the different objects in the graphical output.
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One can associate a colour, a line thickness and a character font to each object. Notice that not all the objects
have both a line thickness and a character font: for example, a title only requires the colour and the character
font to be defined.

• Click an object to select it (use the scroll bar to see the entire list)

• Click one of the option buttons, in the “colours” frame, to select the colour that has to be associated to the
selected object. The Not drawn option hides the object of the graphical output.

• If the object contains texts, one can choose a character font from the list (use the scroll bar to see the entire
list)

• If the object contains lines, one can assign a thickness to the lines (in mm). If the value is zero, the program
uses the thinnest line on the output device.

• It is possible, as an option,  to assign a left and a top margin (in cm) to the whole graphical output.

NOTE: although the available set is limited to fifteen colours, they can be manually customised; double-click the
coloured bar to open the Colour Dialogue Box and choose a different RGB value associated to the selected
colour.
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Exit Menu (ALT,X)

This command allows one to exit the program.

If the file being used contains modifications that have not yet been saved the program will propose the file
saving window, if you would like to save these modifications.
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Chapter 8 - A simple example

A simple example

In this chapter we present a simple example which can be easily duplicated, which we recommend the user
works through, in order to familiarise oneself with the program.

Please remember that the only parts to digitise are commands or input data are those written in bold face while
single keys are shown in SMALL CAPITALS.

1. Start the program by double-clicking on the WELL icon. To close the message window click on the <Ok>
button or press enter or the space bar.

2. You have the program on-line now. Click on file to open the menu and hence click on the Open command.

3. Enter as file name test  in the file name field, hence click on the <Ok> button to confirm.

4. The aquifer used for this example is an artesian aquifer, with a completed well with constant flow, transitory
regime. Let us see what data have to be entered.

5. Click on the Edit menu and select the Piezometric distances command by clicking on it. Enter 60 for the
piezometer distance from the well axis and click on the <Ok> button to end data entering.

6. Open the Edit menu once more and select the Times command. The program can handle up to 50 readings
that can be entered without any precise order as these are automatically sorted by the program every time
one exits from this window. Enter 1 as the first time, TAB to confirm and pass on to the next field, hence
enter the following values; remember to digitise TAB to confirm each value entered and pass on to the next
one:

2 TAB

3 TAB

4 TAB

6 TAB

8 TAB

10 TAB

14 TAB

18 TAB

24 TAB

30 TAB

40 TAB

50 TAB

60 TAB

80 TAB

100 TAB

120 TAB

150 TAB

180 TAB

210 TAB

240 TAB

To finish entering data click on the <Ok> button.

7. We pass on the to the flow window. Open the Edit menu and select Flow. The table shown contains a field
for each of the times entered, in this case, as a constant flow test has been selected the value to be entered
shall be the same for each time. Remember to use the TAB key to move the cursor to the various fields.
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Enter 2.27. Click on the <Ok> button to close the window.

8. Select now from the Edit menu the piezometer drawdown command. As more read-off times have been
defined the program will show a table to enter the drawdown for each piezometer, otherwise, that is to say in
presence of only one time a table with all piezometers will be shown. The piezometer to treat has number 1,
so enter 1 and click on the <Ok> button. The table shown has a field for each of the times entered, by using
the procedure described previously enter the following values:

0.201 TAB

0.302 TAB

0.369 TAB

0.415 TAB

0.485 TAB

0.534 TAB

0.567 TAB

0.625 TAB

0.67 TAB

0.72 TAB

0.76 TAB

0.808 TAB

0.848 TAB

0.879 TAB

0.927 TAB

0.965 TAB

1 TAB

1.042 TAB

1.08 TAB

1.1 TAB

1.112 TAB

Once the data entered have been confirmed as there is one piezometer only and no data have to be edited
click on the <Ok> button to finish.

9. As all data for the calculation have been entered the next step is the selection of the calculation method.
Open the Edit menu and select the Select Method command. The list of all available methods is show with
the last method used highlighted or, in case of a new file, the first one in the list. To select a method move
the selection to the line desired and click the <Ok> button. In this case we shall select the method due to
Theis which can be used to analyse test made in artesian aquifers with completed wells that work with a
constant flow and has only one piezometer with n read-off times. [Artesian - Complete - Transitory - Theis (1
pz.; n t.)].

10. Before performing the calculation open the Edit menu and select the Diagram title command. With this
command one can enter titles as desired, remember to press the tab key to move the cursor to next field in
the window. As one can see, titles that are longer than the field are scrolled hiding a part; it possible to edit
and modify the text using the arrow keys. Confirm by clicking the <Ok> button.

11. Thus one has finished entering the data and the calculations can be executed. Open the Print menu by
clicking on it. The following options are proposed:

- Drawings: within the sub-menu opened through this choice the commands to visualise and print the
interpretative diagram which will differ for each method used is shown. The diagram shows the input data
that have not yet been treated on a Cartesian plane with a logarithmic abscissa and linear ordinate, the bi-
logarithmic diagram of the data not yet treated, on a plane where both axes are logarithmic the optimum flow
diagram is shown.

- Listings: inside the sub-menus activated by this command the commands are show to visualise, print and
export of listings.

- Configure: permits the definition of the colour configurations, the size and set of characters to be used in
the printing of graphics.
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12. Select the Diagram Calculation Result command. After the execution of the calculations, the duration of
which is dependent on the type of computer used, the drawing that shows the calculated results is drawn.
With the instrument bar one can carry out the following operations:

- Zoom +: enlarges a part of a page. Note: if one does not have a character font suited for the visualisation
of the selected dimension, the program will substitute it with another.

- Zoom -: returns the drawing to the original dimension.

- Arrows: clicking on the arrow icons after having activated "Zoom +" one can pan the drawing visible on
screen.

- Print: clicking on this third icon, or pressing the letter p key, will send the drawing to the default printer.
When the printing has finished the program returns to menu.

- Resized print: by clicking on the command the drawing is printed on the default printer resized in such a
way as to be drawn on a single page.

- DXF: clicking on this command gives access to a dialogue box that enables one to assign a different name
to the DXF file, which has by default, the same name as the data file.

- Exit: closes the window and returns to the program.

13. To terminate the work session select the Exit menu. If the file being used contains modifications that have
not yet been saved the program will propose the “Save as” dialogue box. To save the file click on the <Ok>
button.


	Chapter 1 - Introduction to the program
	Introduction to the program

	Chapter 2 - System requirements and program installation
	System requirements
	Program Installation

	Chapter 3 - The program protection
	Hardware protection key
	Hardware protection key - Parallel port
	Windows 95, Windows 98 and Windows Me
	Windows NT, Windows 2000 and Windows XP

	Hardware protection key - USB port
	Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP
	Windows NT



	Chapter 4 - Using the program in a local network
	Using the program in a local network

	Chapter 5 - General information
	Usage Notations

	Chapter 6 - User Interface
	User Interface and Data Entering
	User Interface: Menu Bar and Menus
	The Graphical Output Preview Window
	The Input Dialogue Windows
	Data Input With Tables
	Message Windows
	Help On Line


	Chapter 7 - Commands
	Files Menu (alt,f)
	New Command (alt,f,n)
	Open Command (alt,f,o)
	Save Command (alt,f,s)
	Printer Setup Command (alt,f,c)

	Edit menu (alt,e)
	Well Radius Command (alt,e,r)
	Distances Piezometers Command (alt,e,d)
	Times Command (alt,e,t)
	Flow Command (alt,e,f)
	Drawdown inside the well Command (alt,e,i)
	Drawdown in Piezometer Command (alt,e,p)
	Geometric Parameters Command (alt,e,g)
	Efficiency Parameters (alt,e,e)
	Method Selection Command (alt,e,s)
	Diagram Heading Command (alt,e,m)
	Disactivation Times Command (alt,e,v)

	Print Menu (alt,p)
	Graphics Command (alt,p,g)
	Diagram Calculation Result Command (alt,p,g,d)
	Cartesian Diagram Command (alt,p,g,c)
	Semi-logarithmic Diagram Command (alt,p,g,s)
	Bi-logarithmic Diagram Command (alt,p,g,b)
	Optimal Capacity Diagram Command (alt,p,g,o)
	Drawdown Diagram (Flow) Command (alt,p,g,d)
	Specific Drawdown Diagram (Flow) Command (alt,p,g,f)
	Drawdown Diagram (Specific Flow) Command (alt,p,g,m)

	Listings Command (alt,p,l)
	Listings Preview Command (alt,p,l,p)
	Listings Direct Print Command (alt,p,l,d)
	Listings Export to DOC (alt,p,l,e)
	Listings Export to TXT (alt,p,l,t)
	Listing Export to SLK (alt,p,l,s)

	Configure Command (alt,p,c)

	Exit Menu (alt,x)

	Chapter 8 - A simple example
	A simple example


